## CONTENTS

1 System Overview .......................... 1

2 Basic Data Acquisition .......................... 3
   2.1 Data Modes .................................. 3
   2.2 Start The System .................................. 4
   2.3 Camera Controls .................................. 6
   2.4 Stage Controls .................................. 7
   2.5 Focus Objective Lens .......................... 8
   2.6 Imager Calibration .......................... 10
   2.7 Scanning and Saving Datacubes ................. 12

3 Basic Data Analysis .......................... 15
   3.1 Spectronon Tools .......................... 15
   3.2 Zoom, Pan, Flip, and Rotate Tool ......... 17
   3.3 The Inspector Tool – Spectral Plots .......... 17
   3.4 Region Of Interest (ROI) Tools .............. 18
   3.5 Image Visualization .......................... 23
   3.6 Plot Panel .................................. 28
   3.7 Saving Spectra, Plots, and Images ............ 29

4 Focusing & Calibration Sheets ................. 31
   4.1 Small Focusing Sheet .......................... 31
   4.2 Large Focusing Sheet .......................... 33
   4.3 Aspect Ratio Calibration Sheet ............... 34

5 Contact us for product support ................. 35

6 Copyright Notice .......................... 37
Resonon’s benchtop hyperspectral imaging system is comprised of a Pika hyperspectral imaging camera, linear translation stage, mounting tower, lighting assembly, and software control system. The positions of the imager and lighting assembly are adjustable along the length of the tower. See Figure 1 below.

Resonon’s hyperspectral imagers are line-scan imagers (also referred to as push-broom imagers). Two-dimensional images are constructed by translating the sample relative to the camera. This is typically accomplished by placing the sample on a linear translation stage.

Resonon’s Pika imaging spectrometers are compact, high fidelity, digital instruments for industrial and scientific ap-
Applications. Spectronon is a powerful hyperspectral data visualization and analysis software package we provide as a free download. Spectronon is easy to learn, offers efficient workflow, and is highly extensible by the user for custom applications. Additionally, a number of datacubes can be downloaded from the Resonon website (www.resonon.com) so you can begin exploring hyperspectral data within a few minutes.

SpectrononPro has all the features of Spectronon, but also includes data collection tools that are highly integrated with our Pika imaging spectrometers to streamline the collection of spectral images.

Chapter 1. System Overview
2.1 Data Modes

Hyperspectral data from Resonon imaging systems can be utilized in three forms, as summarized below.

2.1.1 Raw Data

This data is spectrally calibrated but contains the instrument sensor response, sample reflectivity and illumination functions. This is the least useful form, as the spectral curves do not have real units or real physical meaning. The units are in Digital Number (DN).

2.1.2 Radiance

The raw data can be post-processed to radiance. This requires the imager to be specially calibrated (radiometric calibration) by Resonon at the desired aperture. This data form does not include the instrument sensor response function. This function is corrected for by using the Imager Calibration Pack (ICP file) with the Radiance Conversion plugin in Spectronon (additional information is provided in the Spectronon manual chapter on Advanced Data Analysis 1 Correct section of the Spectronon manual). The resulting data is the product of illumination and sample reflectivity. It has the advantage of possessing real units (in Microflicks) and physical meaning [microflick = 1 microwatt per steradian per square centimeter of surface per micrometer of span in wavelength].

2.1.3 Reflectivity/Reflectance

In reflectance mode, both the instrument sensor response and illumination functions are removed. This leaves the data in absolute reflectance. Data can be converted to reflectance in one of four ways described below. These explanation apply mainly to our airborne and outdoor system users as most benchtop users will be in a lighting controlled environment.

1. **White reference**: Data can be processed to reflectance with a quick calibration against a reflection standard. The highest quality reflection standard is Spectralon, but Teflon is acceptable for many applications. (Note: Teflon needs to be sanded with 100 grit sandpaper on an orbital sander to eliminate any specular properties). This calibration is done with the Record Correction Cube feature, as described below under Calibrate Imager. It is important to note that reflection values are only accurate if the solar illumination (cloud, sun angle, etc) does not change between the collection of the correction cube and the collection of datacubes. Data can also be converted to reflectance using Spectronon’s Reflectance Conversion from Spectrally Flat Reference Cube plugin (see Spectronon manual chapter on Advanced Data Analysis 1 Correct for more information).

2. **Known spectral reference in scene**: Once the data is in radiance, the spectrum of a reference object in the scene can be used to correct the rest of the cube. The reference spectrum must be known and in a tab or space delimited file, then use the Convert Radiance Cube to Reflectivity from Spectrally Flat Reference Spectrum plugin (see the Spectronon manual chapter on Advanced Data Analysis 1 Correct for more information).

3. **Downwelling irradiance sensor**: An alternative method for converting data to reflectance is to use a downwelling irradiance sensor. This sensor records the solar spectrum during data acquisition. This data is used,
along with the Imager Calibration Pack (ICP files) supplied by Resonon for both the spectral imager and down-welling sensor, in the **Reflectivity Conversion from Downwelling Irradiance Data** plugin in Spectronon. Again, see the Spectronon manual chapter on Advanced Data Analysis 1 Correct for more information.

4. **Atmospheric Correction**: Data can be converted to reflectance data with the use of atmospheric correction algorithms such as FLAASH (Fast Line of Sight Atmospheric Analysis of Spectral Hypercubes). Please contact Resonon for more information.

### 2.2 Start The System

If you have a lighting system, turn on the lights and let them warm up. It may require 15 to 20 minutes for the illumination to fully stabilize.

With the camera and scanning system connected to your computer, launch **SpectrononPro** software by double-clicking on the SpectrononPro icon or starting SpectrononPro from your Start menu. The SpectrononPro user interface is shown below with the various windows labeled.
Once the software has started, make sure that the imager and stage controls (if used) are enabled. The imager and stage tools will be greyed out if not enabled, as shown below.
You can get the latest version of SpectrononPro by clicking on Help → Check For Updates. This won’t download the latest version, but will give an alert if there is a newer version.

### 2.3 Camera Controls

Exposure parameters can be controlled by clicking on the Camera tab in the Tools Panel.

**Frame Rate** is equal to the number of images acquired each second, and limits the maximum exposure time (Max Exposure Time = 1.0 ÷ Frame Rate).

**Integration Time** (also known as Exposure Time) is the duration of data acquisition for each individual line image.

**Gain** is a factor which increases the signal, but at the expense of signal-to-noise ratio. Try to keep gain as low as possible (preferrably zero), unless absolutely necessary. (Note: The Pika NIR camera does not have a gain control.)
2.4 Stage Controls

You can move the stage manually by clicking on the Jog Stage buttons, located on the tool bar of SpectrononPro. The buttons will move the stage incrementally in either direction. Use the buttons to center the stage underneath the Pika imaging spectrometer.

The stage can be further controlled by clicking on the Stage tab in the Tools Panel.
**Speed Units** is a setting used for different types of stages. **Linear** is used for the standard linear translation stage that is installed on most benchtop systems. **Rotation** is used for a tripod-mounted rotational scanning stage, typically used in outdoor applications. **Motor** displays speed in “motor pulses per second.”

**Stepping Mode** controls the way the stage moves in relation to the imager. When the Stepping Mode box is not checked, the stage and imager both run continuously during the scan time.

When the Stepping Mode box is checked, the stage moves incrementally, an image is acquired while the stage is stationary, the stage moves incrementally again, another image is acquired while the stage is stationary, and so on. This behavior is preferable when the scanning speed is very slow, when the integration time is very long, or to guarantee there is no motion blur in your scan.

**Scanning Speed** is the linear speed of the stage during a scan.

If the “Go Home After” box is checked the stage will return to its starting position after a scan. The speed at which the stage returns to its original position is the **Homing Speed**, and the **Jog Speed** is used for the **Jog Stage** buttons, described above.

### 2.5 Focus Objective Lens

You are now ready to **focus the objective lens** of your Pika imaging spectrometer. At first, this process is somewhat challenging, but with a little practice it becomes quite easy. Begin by clicking on the **Focus** button located on the SpectrononPro tool bar. This will reveal a live image from the camera within your Pika imaging spectrometer. (Wave your hand in the field of view of your Pika imaging spectrometer to confirm that the image is a live view.) One axis of this image represents the spatial (position) axis of your object, and the other is the spectral (wavelength) axis. (To understand this view better, move colored objects within the field of view of your imager after you have focused the objective lens.)

Place an object with multiple light and dark regions within your Pika imaging spectrometer’s field of view. A sheet of paper with dark lines, as provided in the chapter titled **Focusing & Calibration Sheets**, works well. If you are in the field and are observing objects at a distance, direct your Pika towards an object with multiple features, such as a tree with many branches. Unless your lens is already focused, you will see a series of blurry or barely discernable lines in the Image Panel of SpectrononPro.
To adjust the focus, first unlock the focus adjustment. With Schneider lenses, this is done by loosening the locking metal collar on your objective lens using an Allen wrench, size 5/64 inch.

Then rotate the objective lens until you see dark lines from your object come into focus, as shown. Maximize the sharpness of the lines.

Hint: Clicking the Inspector Tool in the Image Panel, and then selecting X tab in the Plots window will reveal a cross-section plot of your image. Viewing this plot allows you to graphically see the sharpness of your focusing. You can zoom in on the X-axis by clicking the Zoom tool and then clicking on the X-axis.

Focusing the outdoor system can be a little more challenging than the benchtop system. If you are focusing on objects that are further than 40 feet start the process with the objective lens screwed in close to the collar. A method that has proven useful is to start the focusing process by increasing the number of lines scanned to 1000. This will give you a large scan area to begin the process. You will need to be out of live focus mode when performing this focusing procedure (“F” button should not be red). When the scan begins make a quarter turn with the lens. Continue to make quarter turns until you are confident your scene is in focus. When making the quarter turn intentionally place your hand in front of the lens. This will create a thin black line in the scan separating one focus length from its neighbor, allowing for easier comparison. This process can take some time, so be patient and remember that it will get easier with practice.

2.5. Focus Objective Lens
Once you have completed focusing, re-tighten the lock to the focus adjustment. Then click on the Focus tool again to toggle the camera live view off.

**Hint:** See our You Tube video on focusing the benchtop system at http://www.youtube.com/resonon.

### 2.6 Imager Calibration

The following discussion describes how to set up your system to scan for reflectance scaled to a reference object. If you wish to collect raw data and convert it to radiance do not perform the following correction process.

#### 2.6.1 Remove Dark Current

SpectrononPro makes it easy to remove the average dark current noise from your scans. Begin by clicking on the Dark Current button on the SpectrononPro toolbar. You will be instructed to block all light entering your Pika imaging spectrometer by blocking the objective lens.

Once you have the objective lens blocked, click OK as instructed. SpectrononPro will then collect multiple dark frames and use these measurements to subtract the dark current noise from your measurements. The Dark Current button on the toolbar will appear with a red check through it as soon as the dark frames have been collected. Once you see the red check, unblock the objective lens.

#### 2.6.2 Set Reflectance Reference

Measuring absolute reflectance of an object requires correction to account for illumination effects. To do this, click on the Response Correction Cube button on the SpectrononPro toolbar. A message will appear telling you to place a reference material within your Pika imaging spectrometer’s field of view. The reference material should be uniform across the imager’s field of view. Examples of reference materials include Spectralon® or sheets of white Teflon.
Once the reference material is in place, click on OK. This will trigger a short scan of the reference material. Once complete, the **Response Correction Cube** will appear with a red check mark, indicating that the data you collect will be scaled in reflectance to your reference material, including flat-fielding to compensate for spatial variations in your lighting.

**Note:** The **Dark Current** button and the **Response Correction Cube** button are disabled in live camera view mode. Click on the **Focus** tool to toggle the camera live view off.

Once the imager is calibrated for both dark current and reflectance reference, the imager will remain calibrated until the references are removed by the user, or the machine is turned off. If the integration time is changed by the user after calibration, the reference signals will be adjusted accordingly. To manually remove the references, click **Spectrometer → Remove Dark Current Cube**, and **Spectrometer → Remove Response Correction Cube**.

For additional help with this process see our Calibration video at [http://www.youtube.com/resonon](http://www.youtube.com/resonon).

### 2.6.3 Adjust Aspect Ratio

Scanning objects continuously (i.e., with Stepping Mode off) is faster and usually the preferred method. However, when scanning continuously the *initial* image will usually be distorted along the scan dimension. To correct this distortion, you must calibrate the Scanning Speed of the stage relative to the or Framerate, which is the line acquisition rate of the camera.

Recall that Pika imaging spectrometers are line-scan instruments. By adjusting the stage speed of the scanning system relative to the frame rate, you are adjusting the spacing of the lines used to assemble your image. Thus, some adjustments are necessary to scan images with a unity aspect ratio that gives the proper proportion between the scan direction and the line direction.

To adjust your scan’s aspect ratio, it is useful to first image an object whose distortion is easy to observe, such as a circle. Print out the **Pixel Aspect Ratio Calibration Sheet** provided in the **Focusing & Calibration Sheets** chapter of this manual for this purpose. After placing an object with circles within the field of view of your Pika imaging spectrometer, record a scan with enough lines that you can see the complete circle. (200 lines are usually sufficient.)

Record the scan by clicking on the **Scan Button**, and a waterfall image should appear in the Image Panel of SpectrononPro. You may need to record several trial images to determine how many lines to scan and where to best position the object.

**Note:** You can stop a scan by re-clicking on the Scan Button, which changes to the Stop Button during the scan.
If your image is distorted along the scan direction, you will need to change the **Scanning Speed** on the **Stage** tab on the **Tools** panel. If your image is elongated along the scan direction, then the stage was moving too slowly in relation to the frame rate (over-sampling), and you need to increase the scanning speed. Conversely, if your image is compacted along the scan direction, then the stage was moving too quickly in relation to the frame rate (under-sampling), and you should decrease the scanning speed.

**Note:** Alternatively, the Framerate can be adjusted in relation to a fixed Scanning Speed. However, a faster Framerate corresponds to a lower maximum Integration Time and thus limits the available signal.

Repeat the above process until your image is no longer distorted. For additional help setting the aspect ratio see our Setting Aspect Ratio video at [http://www.youtube.com/resonon](http://www.youtube.com/resonon).

A distortion-free image with unit aspect ratio is achieved when the stage/object advances the distance of the projected image of one spatial pixel per each line acquired at the imager’s given frame rate. Thus, changing the Framerate setting requires updating the stage speed to maintain unity aspect ratio, while changing only the Integration Time does not. Similarly, changing the working distance of the imager to the stage changes the object magnification, and thus changes the aspect ratio for any particular Framerate and Scanning Speed combination.

### 2.7 Scanning and Saving Datacubes

To scan an image of an object after calibrating the system, place the object on the stage within the imager’s field of view and type in the number of lines you would like to scan in the window just to the left of the **Scan Button**. Record a hyperspectral datacube (the image) by pressing the **Scan Button**. (Click to terminate the scan early, if needed.) Adjust the stage position and increase/decrease the number of lines as needed to cover the object's feature(s) of interest.

A waterfall image of your datacube will appear in the Image Panel of Spectronon, and a new entry labeled **Current Scan** will appear in the **Resource Tree**. To save the scanned datacube, use your mouse to select **Current Scan** and then either right-click or select **Datacube → Save Cube**. This will open a dialog window that allows you to name the datacube and save it in a folder of your choosing. If you do not save your datacube, the **Current Scan** will be overwritten when you record another datacube, and a warning should appear.
For additional help scanning and saving datacubes see our Scanning and Saving video at http://www.youtube.com/resonon. Once an image is scanned, you can use all the visualization and analysis tools of Spectronon on your image.
Spectronon provides visualization and manipulation capabilities for hyperspectral images. SpectrononPro software has all the features of Spectronon, but also enables data acquisition from Resonon’s family of imagers. Spectronon software can be downloaded for free on Resonon’s website http://www.resonon.com/. SpectrononPro comes bundled with any of Resonon’s imaging spectrometers. Additional analysis capabilities are available in software packages such as ENVI®.

This chapter begins with basic operation of Spectronon, such as opening a hyperspectral datacube and viewing the data. A complete description of visualization tools is provided in Chapters 7-9 on Advanced Data Analysis. Chapter 10 on Custom Data Analysis: Writing Plugins discusses how to implement user-written algorithms into Spectronon, enabling custom data analyses.

References to “Spectronon” apply to “SpectrononPro” as well.

### 3.1 Spectronon Tools

To open a datacube, select **File → Open Datacube**.

This will open a dialog that allows you to browse to find your datacube. Select your datacube and click on **Open** to load your datacube. This will result in the following:

- An image of your datacube will appear in the image panel
A listing of the open datacube will appear in the Resource Tree

Tabs will appear in the Parameters window that allow you to change the image (more on this later)

Header information on your datacube will appear in the information panel

Note: Spectronon can open any datacube with an ENVI® formatted header. This includes .bip, bil, and .bsq formats.

This chapter employs an example datacube of M&M® and Reese’s® Pieces candies. (This datacube can be downloaded from Resonon’s website at http://downloads.resonon.com/.) By default, the datacube is opened with a true color image of the data, which approximates the appearance of the object under normal lighting conditions by combining red, green, and blue wavelengths from the datacube.

With a few minutes of practice using the available tools, you will be able to manipulate and visualize hyperspectral data quickly and efficiently.

16 Chapter 3. Basic Data Analysis
3.2 Zoom, Pan, Flip, and Rotate Tool

To zoom to a specific area of the image, select the magnify tool in the toolbar and the cursor will change. Click the magnify tool in the image, and the view will zoom in. It is also possible to click and drag a selection within the image to zoom into the selected area.

To zoom out, select the demagnify tool and click anywhere in the image.

To zoom in and out and recover the original image, select the original size tool and click anywhere in the image.

The user may also zoom in and out using the mouse scroll wheel, if available.

To pan the image while zoomed in, select the pan tool. Click and drag inside of the Image to pan.

Click these tool to rotate left, rotate right, flip vertically, or flip horizontally the image.

3.3 The Inspector Tool – Spectral Plots

The inspector tool allows you to see the spectrum associated with a pixel. Choose the inspector from the toolbar, and then click a point inside the image. This will:

- Plot the spectrum for the pixel in the spectrum plot panel
- List the pixel location (sample and line number) in the data panel
- List the red (R), green (G), and blue (B) brightness values in the data panel
Click on other pixels to see the spectra from other pixels, click and hold while dragging the inspector tool to update the plot panel continuously.

The red, green, and blue vertical lines in the spectral plot indicate the hyperspectral wavelength bands used to generate the current image.

### 3.4 Region Of Interest (ROI) Tools

It is often useful to consider a group of pixels within the image. The ROI tools enable this capability and provide a number of options. As will be seen later, the ROI tool is often used during one of the first steps in classifying different objects within a hyperspectral image.

To select a Region of Interest (ROI), select either the marquee, lasso, or flood fill tool from the menu bar. Click and drag a rectangle of interest with the marquee tool, or click and drag any closed shape with the lasso tool. The floodfill tool can be used to select a contiguous region of spectrally similar pixels. After selecting an area, right-click to reveal a pop-up menu with several options. Holding control while selecting ROIs allows you to append to the existing selection.

**Hint:** The selection menu is also available in the main menu.

The floodfill tool shows pixels that are spectrally similar to the chosen pixel. Spectral similarity is assessed with either Euclidean distance or Spectral Angle Mapper (SAM), along with a tolerance value. The user can set these options by...
Fig. 1: A small ROI on one of the red candies has been selected and a right-click has revealed the popup selection menu.
accessing the Workbench tab from File → Preferences menu.

The use of the floodfill tool depends on an adjustable tolerance parameter. Floodfill operates on a representation of the datacube scaled from zero to one in each band. It calculates the Euclidean distance or SAM angle in spectral space between the clicked pixel and all contiguous pixels and expands the selection until the selected area contains all of the contiguous pixels for which the spectral distance to the clicked pixel is less than the selected tolerance. Increasing the tolerance will result in a larger selected region with greater spectral variability within that region (i.e. it allows pixels that are less similar to the clicked pixel to be included in the selection). Decreasing the tolerance will result in smaller selected regions with greater spectral similarity. As with the other selection tools, holding control while using the floodfill tool will allow a selection to be built up through multiple clicks of the tool.

An ROI consisting of multiple parts of the image has been selected by using the floodfill tool several times.

One of the most useful selection options is mean spectrum. (Descriptions for the other ROI options can be found in Chapter 4.) Selecting the mean spectrum option calculates the mean spectrum of all the pixels within the ROI area you selected and plots the result in the spectral plotter. If the show all spectra standard deviations plugin is activated,
the mean will show as a bold line outlined by two additional +/- standard deviation lines. The standard deviations are hidden in the below example. This is discussed further in the Spectronon manual section on standard-deviation.

Individual spectra can be selected by clicking on the graph of the spectra. You can crop an individual spectrum by selecting it, selecting a rectangular region in the plot window, right clicking to bring up the menu, and selecting crop spectrum. You can also set the range of the plot by selecting Plots → Spectral Plotter → Set Range.

Hint: To examine the plots in more detail, you may resize the plot panel boundary by dragging the edges. Alternatively, click on the magnify tool, then click or drag in the spectral plotter to zoom in. The pan tool will allow you to pan within the spectral plotter as well.

Selecting Mean Spectrum creates a new entry in the resource tree under a new heading, spectra. Right-clicking on the spectrum in the resource tree or selecting Spectrum from the menu bar will reveal a menu of options. Some of the most used options are listed below.
Save Spectrum

Change the name and save the spectrum as a file.

Set Label Color

Open a color picker dialog to change the label color of the spectral plot, and as shown later, classification areas based on this spectrum.

Show Region

Show the originally selected area for the ROI in the current image. This option is useful after you have selected several ROIs.

The color and transparency of the selection can be modified by selecting preferences from the file menu. The selection options are located in the workbench tab of the preferences window. A selection transparency of 1 represents a completely transparent selection (the selection will not be visible), while a selection transparency of 0 represents a completely opaque selection (the underlying render of the datacube will not be visible through the selection).
3.5 Image Visualization

Hyperspectral data can be visualized in far more ways than conventional color images. Image controls are provided in the tool control panel.

By default, the image is displayed in *True Color*, which means three representative bands are used to generate a red-green-blue (RGB) image, approximating how it appears to a human eye. The *Color Infrared* preset option provides a false-color RGB image with the red band set to an infrared wavelength. This option is useful for live vegetation datacubes.

Any time you wish to restore the image to true color, simply click on the *True Color* button under *Presets*. 
To generate false color images, use the sliders or arrows to change the wavelength bands used to create the RGB Image. This tool is often useful when trying to visualize specific spectral features associated with an object in your image. If Auto Update is not selected, click Update to generate the new image.

The Mode menu allows you to identify the band by wavelength (typically the most useful), or by band number.

As an example, of how false-color images can reveal interesting features, move the red slider to approximately 593 nm, and the green slider to approximately 516 nm, then click Update. This generates a new false-colored image, shown below, that reveals there are actually two kinds of red candy, and suggests there are two kinds of yellow candy – each candy type is positioned in the shape of an “I”. (In Chapter 3, a classification technique will show this more clearly.)
Note: The Red, Green, and Blue vertical lines in the Spectral Plot show the location of the bands chosen to create the false-color RGB image.
The Contrast tab in the tool control panel allows you to adjust the image contrast. If Use Contrast Enhancement is not checked, no image enhancement will be done and the tools in the Contrast tab will be not be active.

**Note:** Contrast enhancement does NOT change the hyperspectral data. It only changes the way the image appears.

Generally, contrast enhancement is beneficial. The 2% stretch is the default, and it sets the darkest 2% of the pixels in the image to a value of 0, and the brightest 2% of the pixels in the image to maximum brightness (255). This choice minimizes the impact of glare. You can customize the percentage of the dark pixels set to 0 and the percentage of the bright pixels set to 255 with the sliders. The Linear stretch option sets these percentages to zero.

The Inverse checkbox is useful if you wish to highlight dark pixels.

The Individual Bands checkbox controls whether the brightness levels of the three image layers are considered all together or as individual layers.
It is often useful to view a single band in a standard grayscale (black-and-white) image to visualize the impact of a single spectral feature. To do this, go to the main menu and select Datacube → New Image → Grayscale.

The controls are similar to the RGB controls. If Auto Update is not checked, be sure to click Update after moving the slider to see the grayscale image for a new band.

As with the RGB images, a vertical line in the Spectral Plot shows the band you have chosen. Note that even though the image is from a single band, the Inspector and ROI Tools will continue to plot and operate on all wavelengths.
Hint: With Auto Update selected in the tool control panel, you can quickly scroll through single band images.

Warning: For large datacubes or slow computers, the Auto Update refresh rate may be slow.

3.6 Plot Panel

The plot panel allows you to visualize hyperspectral data graphically. This has already been seen with the use of the Inspector and ROI tools, but here we explore the plot panel in more detail.

The plot panel has three tabs: Spectra, X, and Y. These three tabs provide you with plots along the three axes of a datacube using the Inspector Tool, as shown below.

Clicking on the X and Y tabs in the plot panel accesses the corresponding cross-sectional plots. The plot will show the intensity versus position value for the RGB bands used to create the image or the Grayscale band if used with a grayscale image.

Note: The direction of X and Y depends on the orientation of your cube. Moving the Inspector Tool should reveal which axis you are plotting.
Hint: Use the magnify tool, the demagnify tool, and the pan tool in the spectral plotter to navigate and examine features.

3.7 Saving Spectra, Plots, and Images

Spectronon makes it easy to save the results of your work for further investigations or for making presentations.

To save a spectrum, click the spectrum you wish to save in the Resource Tree, and then you may either (1) use the Spectrum menu in the main menu, or (2) right-click on the spectrum in the Resource Tree to reveal the menu shown below. From this menu, select either Save Spectrum or Save Spectrum As... This will open a save dialog. Once saved, the new name will appear when the file is plotted in the spectral plotter, and the file can be re-opened for use in later sessions.

Select the menu option Copy Spectrum As Text to copy the data onto your clipboard, from which you can paste it into other applications such as Notepad and Excel.

To save a plot use the Plots menu as shown above. Select which plot you wish to save (Spectral, X Cross Section, or Y Cross Section), and then select Save as Image to save as an image or Save as Text to save the plotted data as tables in text file. Both options will pop up a save Dialog.

To Save an Image, select Image from the main menu, and then Export Image... This will pop up a save dialog.
FOCUSING & CALIBRATION SHEETS

Use the focusing sheets to focus the objective lens, and use the aspect ratio calibration sheet to set the stage speed and imager framerate. See the chapter on Basic Data Acquisition for details.

4.1 Small Focusing Sheet

Focusing Sheet
4.2 Large Focusing Sheet

Focusing Sheet
4.3 Aspect Ratio Calibration Sheet

Aspect Ratio Calibration Sheet

- Increase stage speed or decrease frame rate
- Calibrated 1:1 ratio
- Decrease stage speed or increase frame rate
CHAPTER FIVE

CONTACT US FOR PRODUCT SUPPORT

Phone: (406) 586-3356
Website: www.resonon.com
Email: productsupport@resonon.com
Also see our product support webpage located at:
http://resonon.com/product_support.html
COPYRIGHT NOTICE

Copyright © October 2016 Resonon Inc. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or by any means (electronic or mechanical, including photocopying) for any purpose without written permission from Resonon. Resonon will not be responsible or liable for any accidental or inevitable damage that may result from unauthorized access or modifications.

This document may contain errors or inaccuracies, and it may be revised without advance notice. This manual is updated frequently.

Please see our software copyright and EULA at

Resonon welcomes any recommendations regarding this manual. Customer feedback is always welcome as it helps us to continuously improve upon the quality of our products.

Please contact us at Resonon with any questions or comments. We look forward to hearing from you.